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I. Introduction 

An Overview of Kapelle Scales 

Kapelle Scales is an application designed for working with scales 
and modes of all sorts. It allows the practice of writing, hearing, 
identifying, error-correcting, and playing scales, together with 
material related to key signatures such as creating or selecting key 
signatures. 

Kapelle Scales is designed to be as extensible and flexible as 
possible. It is not hard-wired as to the scales and modes it 
understands or can present, but may be easily extended by anyone 
who knows how to use the application Kapelle. 

Kapelle Scales does not hard-wire the specific exercises it presents 
to the user, either. Kapelle Scales exercises are text files, similar to 
the INI files used in Windows, which dictate how the application will 
create an exercise. As a result, Kapelle Scales may be tailored to 
suit any class, any curriculum, any particular teaching style. 
Exercise template files are small and may be as numerous as 
necessary. 

Extensibility 

Kapelle Scales is fully extensible as to the number of scales and 
modes it understands and is capable of presenting. The list of 
scales it may draw from is located in a Kapelle-format (.kpl) file, 
Scales.kpl, which must be present in the application directory for 
the program to run. 

Adding new scales to those already understood by Kapelle Scales is 
a simple matter of adding more notated scales (plus the name to 
be used for the scale) to this file. 

Flexibility 

Kapelle Scale’s flexibility is guaranteed given that it does not hard-
wire any specific exercises into the application. Instead, exercises 
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are created as plain-text files, which contain instructions that 
specify how a particular exercise is to be created. 

This instruction file can specify the scales and modes to use in the 
exercise, the type of exercise (see Chapter II), the number of 
scales to include in a single exercise, plus a host of other options—
including the use of all 7 clefs. Due to this technique of creating 
and presenting exercises, Kapelle Scales can be said to present 
unlimited possibilities for scale-related exercises. 
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II. The Types of Exercises in Kapelle Scales 

You can do a lot with scales. Kapelle Scales has targeted no less 
than 12 different scale-related activities, each of which might 
contain a number of sub-options. 

It should be stressed that in almost all types of exercises, the 
starting and ending degree of the scale may be specified as being 
other than 1. In addition, all 7 clefs may be used; the exercise may 
restrict itself to one clef throughout, or each presented scale may 
use its own clef. The selection of clefs may be specified in the 
exercise template file, along with every other pertinent option. 

It is possible to categorize the exercise types into larger categories, 
which are: writing, adding accidentals, adding key signatures, 
identifying, error-correcting, and playing. 

For full information on the options available in specifying an 
individual scale exercise, see the ScaleMaker User Manual, which 
gives full instruction on the creating of an exercise template file 
using the ScaleMaker application (which simplifies and safeguards 
the process in the place of writing the file using a text editor.) 

Writing Scales 

Writing scales involves notating a scale. The options for this activity 
are: 

• Whether or not to give the first note. 

• Whether or not to give a key signature, or require the 
use of accidentals. 

Adding Accidentals to Scales 

A scale in all naturals can be presented, with its tonic and mode 
identified. The user is then asked to add the appropriate accidentals 
in order to create the requested scale. 
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Adding Key Signatures to Scales 

A scale in all naturals can be presented, with its tonic and mode 
identified. The user is then asked to either selected or create a key 
signature that will produce that tonic and mode from the all-
naturals scale. 

The scale may be selected from a list of possibilities, or it might be 
created by assembling accidentals onto a staff. 

Identifying Scales 

Scales may be shown to the user, and the user required to identify 
the scale. 

Identifying Scales at Sight 

A complete scale can be shown and the user required to identify 
the tonic and mode. 

Identifying Scales by Ear 

A complete scale can be played, and the user required to identify 
the scale. There are two different ways to do this: 

• The first pitch can be given and the user required to 
identify both tonic and mode. 

• No pitches given and the user required to identify the 
mode only. 

Identifying Scales by Single Scale Degree 

A single scale degree can be given, together with the mode of a 
scale, and the user required to identify the tonic. 

Error-Correcting Scales 

In error-correction practice, a scale is written and identified by 
tonic and mode. It can contain errors which are then corrected by 
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the user. 

The number of errors and the specific scale degrees on which they 
occur may be specified in the exercise template. 

Playing Scales 

Scales may be played in two different ways: 

• The user may be asked to play a particular scale from 
scale degree to scale degree. 

• The user may be asked to play a given mode from a 
given note as the first scale degree. 
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III. Opening an Exercise 

Kapelle Scales does not use a traditional File Menu-based “open” 
command to open an exercise. Instead, the Tree Control Pane on 
the left side of the window displays icons for those exercises which 
the program can open. 

 
Figure 1: The Location of the Tree Control Pane 

If the Exercise Names are Truncated 

If the exercise names are longer than the width of the Tree Control 
Pane, you can read the entire name by holding the mouse pointer 
over the name of an exercise that is truncated by the right margin 
of the pane. 

The full name of the exercise will be displayed in a little yellow 
window. 

 
Figure 2: Viewing the Full Name of an Exercise 

Adjusting the Tree Control Pane Size 

The width of the Tree Control Pane may be adjusted. 

Tree Control Pane 
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To adjust the size, positioned the caret over the vertical bar 
separating the Tree Control Pane from the Main Window. The caret 
will change shape to a double-headed arrow. 

 
Figure 3: Adjusting the Tree Control Pane Size 

Then drag the bar to the new location. When you release the 
mouse button, the Tree Control Pane will be the new size. 

Selecting an Exercise to Open 

Navigating the Tree Control Pane 

There are two types of items in the Tree Control Pane: folders, and 
exercises. 

Folders look like this:  

Exercises look like this:  

Opening Folders 

A folder is closed when there is a plus sign to the left of the folder. 
Open such a folder by clicking on the plus sign. 

Closing Folders 

When a folder is open, there is a minus sign to the left of the 
folder. Close such a folder by clicking on the minus sign. 

 
Figure 4: Open and Closed Folders 
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Selecting Individual Exercises 

Click once on the icon or name of the exercise to select it. 

 
Figure 5: A Selected Exercise 

Opening an Exercise 

To open an exercise that has been selected, do any one of the 
following: 

• Double-click on the exercise’s name or icon. 

• Select “Open Exercise” from the File Menu. 

• Press Ctrl+O. (That’s the letter ‘O’, not the zero.) 

• Right-click on the exercises’s name or icon, and then 
choose “Open Exercise” from the Context Menu. 

 
Figure 6: Right-Clicking to Open an Exercise 

What Happens After Opening an Exercise 

After you have opened the exercise, Kapelle Scales goes to work 
creating a series of scales for you to work with, based on the 
instructions contained in the exercise. 

While it is working, the caret will take on the standard “wait” caret 
shape—an hourglass on most systems. However, in all but the most 
extreme conditions this process will be virtually instantaneous. As 
soon as the collection of new scales has been created, you will be 
presented with the first scale to work with. 
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IV. Working Through an Exercise 

The Parts of the Main Window 

The Main Window is comprised of four primary viewing areas, or 
“panes”. 

Not all four panes are always visible at the same time. A particular 
pane is visible only when it is needed. 

 
Figure 7: The Main Window 

Announcements Pane 

The Announcements Pane contains instructions and information. 
The contents of this pane change during the duration of an 
exercise. Among the information which the Announcements Pane 
displays: 

• Instructions for carrying out the tasks—whether to 
play, write, identify, etc. 

• The key and mode of the scale as appropriate by the 
type of exercise. 

• The starting and ending scale degrees of the scale, as 
appropriate by the type of exercise. 

• Your scores for the current scale and the running 

Announcements Pane 

Notation Pane 

Source Pane 

Comment Pane 
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accumulated summary. 

• Directions for continuing. 

Always read the Announcements Pane carefully during an exercise. 

Notation Pane 

The Notation Pane displays a single measure, in which the scale 
you are to work with is displayed. 

The contents of this single measure vary depending on the type of 
exercise. For example, in a writing-scales exercise, it will be either 
blank or will contain the starting note for the exercise. 

When you work with notation elements of a scale (writing notes, 
adding accidentals, error correction, etc.,) you work within the 
Notation Pane. 

Directly below the Notation Pane is a narrow colored band. This 
band serves a number of purposes, depending on the current state 
of the exercise. 

• It may act as an onscreen button—watch it for 
instructions. 

• It may be used to display the tonic and/or mode of the 
scale. 

Source Pane 

The “source” is the original scale that was used to create the 
exercise in the first place—in other words the “correct” scale. The 
Source Pane displays that scale as well as its tonic and mode. 

The Source Pane is never displayed unless the current scale has 
been evaluated by the program. 

Comment Pane 

Most exercises include a comment. This is a line of text which was 
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written by the author of the exercise, and which provides extra 
information about that exercise. 

Most comments are short. However, the Comment Pane can sprout 
a vertical scroll bar if the comment is too long to fit within the 
space allotted. 

Reading the Announcements Pane 

When you start working on an exercise, be sure to read the 
Announcements Pane carefully: it will tell you what you need to 
know about carrying out the exercise. 

Consider this set of instructions: 

 
Figure 8: A Typical Instruction 

This instruction tells you to: 

• Notate an ascending A-Major scale. 

• Start and end on the first scale degrees. 

• Use accidentals instead of a key signature. 

• Give the Answer Ready command (which can be 
accessed from the keyboard via F5) when you have 
ginished. 

Always be sure to check whether you are supposed to work with an 
ascending or descending scale. 

Carrying Out the Instructions 

Once you know what you need to do, you then set about doing it. 
This can entail a number of different activities, including: 
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• Notating scales 

• Identifying the tonic, or mode, or both, of a given 
scale 

• Adding accidentals to a scale 

• Error-correcting a scale 

• Adding a key signature 

• Playing a scale 

• Identifying a scale by ear after it is played for you 

Signifying Your Answer is Ready 

When you have finished with a scale, tell Kapelle Scales that your 
answer is ready. Kapelle Scales will then evaluate your work on this 
particular scale and calculate your score. 

The Answer Ready command may be accessed by any of the 
following techniques: 

• Press F5. 

• Select Answer Ready from the Scale Menu. 

• Click the Answer Ready icon  on the Toolbar. 

• Right-click in the Notation Pane and select Answer 
Ready from the Context Menu. 

Getting a New Scale 

Most exercises consist of a series of scales. Your goal is to carry out 
the assigned task for each scale in turn. After you have worked 
through all of the scales in the exercise, your final score is tallied 
and recorded. 
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Once you complete one scale, you ask for another until the exercise 
is complete. Note that the New Scale command is not available 
until the current scale has been evaluated. 

Access the New Scale command by any of the following 
techniques: 

• Press Ctrl+N. 

• Select New Scale from the Scale Menu. 

• Click the New Scale icon  on the Toolbar. 

• Right-click in the Notation Pane and select New Scale 
from the Context Menu. 

When the Exercise Is Complete 

When the exercise is complete, the Announcements Pane will 
change to look as follows: 

 
Figure 9: Exercise Complete Announcement 

At this point your final score has been written to your progress 
report. For information about your progress report, see the chapter 
Progress Reports on page 44. 

Stopping the Exercise Prematurely 

If you want to stop an exercise before it has fully completed—that 
is, before you have worked through all of the scales in the 
exercise—you may give the Stop Exercise command, which will 
stop the exercise at that point. 

The Stop Exercise command results in your final score not being 
recorded. 
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You will be asked if this is really your intention before continuing, 
since once the exercise is stopped, your accumulated score up to 
that point is lost. 

You may prefer to save your place in the current exercise instead: 
this will allow you to return to the exercise at some other time, 
retaining your current accumulated score. To do this, see the 
chapter Saving and Restoring Your Place on page 44. 

You may access the Stop Exercise command by any of the 
following techniques: 

• Press Ctrl+S. 

• Select Stop Exercise from the Scale Menu. 

• Click on the Stop Exercise icon  on the Toolbar. 

• Right-click in the Notation Pane and select Stop 
Exercise from the Context Menu. 
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V. Notation Techniques 

A number of the Kapelle Scales exercise styles involve some kind of 
musical notation. This may be writing a complete scale, writing only 
part of a scale, adding accidentals, or even correcting errors on a 
displayed scale. 

To carry out these tasks you need to learn to use the Kapelle 
Scales notational system. 

Kapelle Scales is built on the same Apollo library as all of the other 
programs in the Kapelle series and therefore the notational system 
will be no surprise to anyone familiar with these other programs. 

Moving the Caret 

The onscreen caret (also called a ‘caret’) is a blinking rectangle in 
inverse video. It is displayed in the Notation Pane for those 
exercises which require some form of musical notation. 

 
Figure 10: The Caret 

The onscreen caret is available only when it is needed. So it is not 
visible at all times the Notation Pane is visible. 

TIP: if you think the caret should be visible and it isn’t, click in the 
Notation Pane. If the caret does not appear, then this style of 
exercise does not require a caret. 

The vertical location of the caret determines the pitch of the note; 
the horizontal, the time. 

The caret may be moved with the mouse or with the arrow keys on 
the keyboard. 



Kapelle Scales User Manual 
Page 19 

Moving the Caret With the Mouse 

To move the caret with the mouse, click on the location where you 
would like the caret to appear. Note that the caret moves 
horizontally only to locations already occupied by notes—or it 
defaults to the position of the first note in the measure. 

Moving the Caret With the Arrow Keys 

To move the caret with the arrow keys, press the arrow key 
corresponding to the direction of motion you desire: up, down, 
right, or left. 

The caret’s motion is constrained by practical limitations. These 
are: 

• The caret cannot be positioned higher than the top 
border of the Notation Pane. 

• The caret cannot be positioned lower than the bottom 
border of the Notation Pane. 

• The caret cannot be positioned to the left of the first 
note. 

• The caret cannot be positioned to the right of the last 
note. 

Determining the Current Pitch 

When the caret moves beyond the staff boundaries, it may be 
difficult to ascertain the current pitch—since the caret does not 
display any leger lines. 

The pitch is always displayed in the Status Bar on the bottom right 
of the application’s window, though: 

 
Figure 11: Status Bar 



Kapelle Scales User Manual 
Page 20 

Entering Notes 

Entering a note automatically places it at the end of the current 
measure. 

To enter a note, first position the caret at the vertical location 
where the note should be placed. Then give the Enter Note 
command. A half-note (the only note value used in Kapelle Scales) 
will be added to the end of the measure. 

The Enter Note command may be accessed by any of the following 
techniques: 

• Press the Enter key. 

• Select Enter Note from the Note Menu. 

• Click the Enter Note icon  on the Toolbar. 

• Right-click in the Notation Pane and select Enter Note 
from the Context Menu. 

Inserting Notes 

“Inserting” a note means to place a note at a particular location in 
the measure, instead of at the end of the measure (which is 
“entering” a note.) 

To insert a note, first place the caret at the horizontal and vertical 
location (time and pitch) where you would like the new note to be 
positioned. Then give the Insert Note command. A half-note (the 
only note value used in Kapelle Scales) will be inserted at that 
location—the notes following it are pushed over to make room. 

The Insert Note command may be accessed by any of the 
following techniques: 

• Press Shift+Enter. 
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• Select Insert Note from the Note Menu. 

• Click the Insert Note icon  on the Toolbar. 

• Right-click in the Notation Pane and select Insert 
Note from the Context Menu. 

Selecting Notes 

Notes may be selected for editing either singly or as part of a group 
of selected notes. 

The note’s head is the important part of the note for selection 
purposes, not its stem. 

Selecting a Single Note 

To select a single note, position the caret directly on the note’s 
head. 

In this illustration, the ‘g’ is selected: 

 
Figure 12: A Selected Note 

Selecting Multiple Notes 

To select multiple notes, drag a selection rectangle around them, 
being sure to enclose the heads of the notes you wish to select. 

To drag the selection rectangle, click the mouse at the top-left 
corner of the rectangle and drag down to the bottom-right corner. 

 
Figure 13: A Selection Rectangle 

When you release the mouse button, the area you have selected 



Kapelle Scales User Manual 
Page 22 

will be shown in inverse video. In this illustration, the ‘a’, ‘g’, and ‘f’ 
are selected. 

 
Figure 14: Selecting Multiple Notes 

Selecting All Notes 

The Select All command can provide a convenient shortcut if you 
wish to select all of the notes in the measure. 

You may access the Select All command by any of the following 
techniques: 

• Select Select All from the Edit Menu. 

• Press Ctrl+A. 

Deleting Notes 

To delete notes, first select the note or notes you wish to delete, 
then give the Delete Note command. 

The Delete Note command may be accessed by any of the 
following techniques: 

• Press the Backspace key. 

• Select Delete Note from the Note Menu. 

• Click the Delete Note icon  on the Toolbar. 

• Right-click in the Notation Pane and select Delete 
Note from the Context Menu. 
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Clearing All Notes 

A shortcut command for clearing out all the notes in the measure is 
provided. You do not have to select any notes for this to work. 

To clear all the notes in the measure, give the Clear All command. 
This command may be accessed by the following technique: 

• Select Clear All from the Edit Menu. 

Flatting Notes 

To flat (lower a chromatic half-step) a note or group of notes, first 
select the note or group of notes you wish to flat, then give the 
Flat command. 

The Flat command may be accessed by any of the following 
techniques: 

• Press F7. 

• Select Flat from the Note Menu. 

• Click the Flat icon  on the Toolbar. 

• Right-click in the Notation Pane and select Flat from 
the Context Menu. 

Sharping Notes 

To sharp (raise a chromatic half-step) a note or group of notes, 
first select the note or group of notes you wish to sharp, then give 
the Sharp command. 

The Sharp command may be accessed by any of the following 
techniques: 

• Press F8. 
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• Select Sharp from the Note Menu. 

• Click the Sharp icon  on the Toolbar. 

• Right-click in the Notation Pane and select Sharp from 
the Context Menu. 

Moving Notes 

You may move notes upwards or downwards by a line or space at a 
time. 

To move notes, first select them, then give either the Move Note 
Up or Move Note Down commands. 

These commands are accessed by any of the following techniques: 

• Press Ctrl+Shift+Down Arrow or Ctrl+Shift+Up 
Arrow. 

• Select Move Note Down or Move Note Up from the 
Note Menu. 

• Click the Move Note Down icon   or the Move 

Note Up icon  on the Toolbar. 

• Right-click in the Notation Pane and select Move Note 
Down or Move Note Up from the Context Menu. 



Kapelle Scales User Manual 
Page 25 

VI. Using the Clipboard 

Kapelle Scales offers full support of the Windows clipboard, allowing 
you to copy, cut, and paste notes into the Notation Pane. 

The Clipboard commands are enabled only when you are working 
on an exercise which requires clipboard support—specifically one of 
the styles which involves writing the notes of a scale. 

Copying Notes 

To copy a note or a group of notes to the clipboard, first select the 
note or group of notes you wish to copy. Then give the Copy 
command. 

The Copy command can be accessed by any of the following 
techniques: 

• Press Ctrl+C. 

• Select Copy from the Edit Menu. 

Cutting Notes 

The term “cut” means to make a copy of a note or group of notes 
to the clipboard, then to delete those notes from the Notation Pane. 

To cut a note or group of notes, first select the note or group of 
notes you wish to cut. Then give the Cut command. 

The Cut command can be accessed by any of the following 
techniques: 

• Press Ctrl+X. 

• Select Cut from the Edit Menu. 
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Pasting Notes 

Kapelle Scales allows you to paste the Clipboard contents into the 
Notation Pane. You have three options for the location of the pasted 
notes: immediately before the insertion point, immediately after 
the insertion point, or in place of a multiple selection. 

NOTE: since Kapelle Scales displays only one single measure of 
notes at a time, and since no measure may contain more notes 
than the meter allows, the entire contents of the Clipboard may not 
be pasted into the Notation Pane if that would result in 
“overrunning” the measure. 

Pasting Before the Insertion Point 

Pasting before the insertion point is the default. To do this, place 
the insertion point where you would like the pasted note(s) to 
appear, and then give the Paste command. 

NOTE: the Paste command will not be available if there is a 
rectangular selection—even if that selection encompasses only one 
note. 

The Paste command can be accessed by any of the following 
techniques: 

• Press Ctrl+V. 

• Select Paste from the Edit Menu. 

Pasting After the Insertion Point 

If you prefer to paste in the notes after the current insertion point, 
use the Paste After command. 

NOTE: the Paste After command will not be available if there is a 
rectangular selection—even if that selection encompasses only one 
note. 

The Paste After command may be accessed by any of the 
following techniques: 
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• Press Ctrl+Shift+V. 

• Select Paste After from the Edit Menu. 

Pasting to Replace the Selection 

You may insert the contents of the clipboard into a rectangular 
selection—replacing those contents—via the Paste Replace 
command. 

NOTE: the Paste Replace command is enabled only if there is a 
rectangular selection—and, of course, if there is material on the 
Clipboard to paste. 

The Paste Replace command may be accessed by any of the 
following techniques: 

• Press Ctrl+Alt+V. 

• Select Paste Replace from the Edit Menu. 
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VII. Undo and Redo 

Kapelle Scales allows you to Undo—i.e., “take back”—actions you 
have done during a notation editing session. 

You may also “take back” the Undo—what is called a “Redo”. 

Kapelle Scales allows unlimited levels of Undo; you may Undo your 
actions all the way back to your very first edit on a particular scale. 
You may also select to Undo multiple actions—and conversely to 
Redo them—with a convenient shortcut command. 

The Undo/Redo commands are available only in those styles which 
require musical notation: writing, adding accidentals, adding or 
creating key signatures, or error correction. 

To Undo a Single Action 

To Undo a single action, use the command Undo <Action> on the 
Edit Menu—where <Action> is the name of the most recent undo-
able task. Examples might include Undo Add Note, Undo Delete 
Note, or Undo Flat Note. 

The Undo command can be accessed by any of the following 
techniques: 

• Press Ctrl+Z. 

• Select Undo from the Edit Menu. 

To Undo Multiple Actions 

To Undo more than one action, use the command Undo Multiple. 

The Undo Multiple command can be accessed by the following 
technique: 
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• Select Undo Multiple from the Edit Menu. 

This will produce the Undo Multiple Dialog Box: 

 
Figure 15: Undo Multiple Dialog Box 

Select the last action you wish to Undo by clicking on it. This will 
automatically select all actions up to the most recent one—Undo 
must be carried out sequentially to avoid corrupting the data. In 
this example, the third action down (“Add note”) has been clicked 
on; note how the first two actions (“Move note down” and “Flat 
note”) have been included in the selection: 

 
Figure 16: Undo Multiple with Three Actions Selected 

To Redo a Single Action 

After you Undo an action, you can “take back” the Undo—which is a 
Redo. To Redo a single action, use the Redo <Action> command, 
where <Action> is the name of the most recent Undo task. 

The Redo command can be accessed by any of the following 
techniques: 

• Press Ctrl+R. 

• Select Redo from the Edit Menu. 
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To Redo Multiple Actions 

You may redo multiple undone actions via the Redo Multiple 
command. 

The Redo Multiple command can be accessed by the following 
technique: 

• Select Redo Multiple from the Edit Menu. 

This will produce the Redo Multiple Dialog Box, from which you 
selected the actions to Redo. This dialog is functionally identical to 
the Undo Multiple Dialog Box. 

For information about the Redo Multiple Dialog Box, see the section 
“To Undo Multiple Actions” on page 28. 
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VIII. Identifying a Scale 

A number of scale activities involve identifying scales. You may be 
asked to identify a scale’s mode, its tonic, or both its tonic and 
mode. 

In any scale activity which involves identifying a scale, the color bar 
beneath the Notation Pane will become a double-clickable button. 
The caption on that bar will change, depending on the action you 
will be carrying out: 

 
Figure 17: Double-Clicking to Identify Tonic and Mode 

 
Figure 18: Double-Clicking to Identify the Tonic 

 
Figure 19: Double-Clicking to Identify the Mode 

Identifying Mode Only 

When asked to identify the mode of a scale, you give the Identify 
Mode command. 

The Identify Mode command can be accessed by any of the 
following techniques: 

• Double-click on the Notation Pane color bar. 

• Press Ctrl+D. 

• Select Identify Mode from the Scale Menu. 

• Right-click in the Notation Pane and select Identify 
Mode from the Context Menu. 

This command produces the Identify Mode Dialog Box. 
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Figure 20: Identify Mode Dialog Box 

Select the mode from the drop-down list box, then click OK (or 
press Enter). 

TIP: type the first letter of the mode’s name to automatically select 
the mode. Since there might be more than one mode starting with 
that letter, you might need to type the letter more than once—the 
selected names will cycle. 

NOTE: the drop-down list box will contain only those modes which 
are used in this particular exercise, not all possible modes. 

Identifying Tonic and Mode 

When asked to identify both the tonic and mode of a scale, you 
give the Identify Scale command. 

The Identify Scale command can be accessed by any of the 
following techniques: 

• Double-click on the Notation Pane color bar. 

• Press Ctrl+I. 

• Select Identify Scale from the Scale Menu. 

• Click the Identify Scale icon  on the Toolbar. 

• Right-click in the Notation Pane and select Identify 
Scale from the Context Menu. 

This will produce the Identify Scale Dialog Box. 
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Figure 21: Identify Scale Dialog Box 

Select the tonic pitch from the Key drop-down list box, and the 
mode from the Mode drop-down list box, then click OK (or press 
Enter). 

TIP: you may move from list box to list box via the Tab key. 

TIP: you can select the key or mode by typing in the first letter 
when the respective drop-down list box is selected. If there is more 
than one entry beginning with that letter, the list box will cycle 
through the available selections. For example, typing ‘c’ for the Key 
drop-down list box will result in selecting Cb,C,C# in sequence. 

NOTE: the Key drop-down list box will list all available tonic 
pitches—even highly unlikely ones like F#. The Mode drop-down list 
box, on the other hand, lists only those modes which are used in 
this exercise. 

Identifying Tonic Only 

When asked to identify the tonic of a scale, give the Identify 
Tonic command. 

The Identify Tonic command can be accessed by any of the 
following techniques: 

• Double-click the Notation Pane color bar. 

• Press Ctrl+Y. 

• Select Identify Tonic from the Scale Menu. 

• Right-click in the Notation Pane and select Identify 
Tonic from the Context Menu. 
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This command will produce the Identify Tonic Dialog Box. 

 
Figure 22: Identify Tonic Dialog Box 

Select the tonic from the drop-down list box and click OK (or press 
Enter). 

TIP: typing the first letter of the tonic pitch will select the first 
candidate in the drop-down list box that matches. Typing the first 
letter repeatedly will cycle through the available matches. For 
example, typing ‘f’ will select Fb,F, and F# sequentially. 
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IX. Key Signatures 

There are two exercise styles which require the selection or 
creation of key signatures. 

When you select a key signature, you indicate the number of 
sharps or flats you require. An exercise requiring this action will use 
the Notation Pane color bar as a double-clickable button, with this 
text: 

 
Figure 23: Double-Clicking to Select a Key Signature 

When you create a key signature, you actually construct it visually 
by placing sharps or flats onto a staff. An exercise requiring this 
action will use the Notation Pane color bar as a double-clickable 
button, with this text: 

 
Figure 24: Double-Clicking to Create a Key Signature 

Selecting Key Signatures 

To select a key signature, use the Select Key Signature 
command. 

The Select Key Signature command can be accessed by any of 
the following techniques: 

• Double-click the Notation Pane color bar. 

• Press Ctrl+K. 

• Select Select Key Signature from the Scale Menu. 

• Right-click in the Notation Pane and select Select Key 
Signature from the Context Menu. 

This command produces the Select Key Signature Dialog Box. 
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Figure 25: Select Key Signature Dialog Box 

Use the Number of accidentals slider control to select the number 
of accidentals, from 0 to 7, that the key signature will have. 

Use the Type of accidentals radio buttons to select whether the key 
signature is composed of flats or sharps. 

The text under the Number of accidentals slider control will change 
to reflect both the number and type of accidentals in the key 
signature. 

When you have selected the key signature, click OK (or press 
Enter.) 

TIP: when the Number of accidentals slider control is selected (it 
has a light gray rectangle around it) you may move the slider 
control with the left and right arrow keys. 

TIP: the tab control allows you to select the dialog box controls in 
turn. 

Creating Key Signatures 

When asked to create a key signature, use the Create Key 
Signature command. 

The Create Key Signature command can be accessed by any of 
the following techniques: 

• Double-click on the Notation Pane color bar. 

• Press Ctrl+E. 
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• Select Create Key Signature from the Scale Menu. 

• Right-click in the Notation Pane and select Create Key 
Signature from the Context Menu. 

This command produces the Create Key Signature Dialog Box. 

 
Figure 26: Create Key Signature Dialog Box 

Click the mouse on the lines and spaces in the working area to 
place accidentals at the appropriate locations. 

Note that the working area is divided into eight columns: the first 
column contains the clef, and the remaining columns are empty 
when you first open the dialog box. 

Each column can contain one accidental. 

The accidentals that are added to these columns are sharps if the 
Use Sharps radio button is selected, flats if the Use Flats radio 
button is selected. 

Mouse Clicks in the Working Area 

A mouse click in the working area can have three different results, 
depending on the situation in that particular column: 

• If the column is empty, the mouse click will place an 
accidental at the click location. 

• If the column contains an accidental and the mouse 
click is not on that accidental, the extant accidental 
will be moved to the click location. 

Working Area 

Command Buttons 
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• If the column contains an accidental and the mouse 
click is directly on that accidental, the accidental will 
be selected—it will turn red. (If the accidental is 
already selected, then clicking on it will deselect it.) 

Command Buttons 

The command buttons are enabled and disabled according to 
conditions in the Working Area. 

Select All 

The Select All button selects all accidentals in the working area. It 
is not enabled if the Working Area is empty. 

Deselect All 

The Deselect All button deselects all accidentals in the Working 
Area. It is not enabled if the Working Area is empty, or if none of 
the accidentals have been selected. 

Delete 

The Delete button will result in the deletion of any selected 
accidental. It is enabled only if there is at least one selected 
accidental in the Working Area. 

Delete All 

The Delete All button results in the deletion of all accidentals in the 
Working Area. It is enabled if there is at least one accidental 
present. Selection or non-selection of accidentals has no bearing on 
this button. 

Nudge Up 

The Nudge Up button will move any selected accidental(s) upwards 
by one line or space. It is enabled if there is at least one selected 
accidental in the Working Area. 

Nudge Down 

The Nudge Down button will move any selected accidental(s) 
downwards by one line or space. It is enabled if there is at least 
one selected accidental in the Working Area. 
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Confirming Your Work and Exiting 

When you have created a key signature and are satisfied that it is 
correct, click the OK button (or press Enter.) 

If the Dialog Box Will Not Close 

You may see the following message when you attempt to exit the 
Create Key Signature dialog box: 

 
Figure 27: Invalid Key Signature Dialog Box 

This means that your key signature wasn’t a valid one. Your key 
signature must be valid or else the dialog box will not close. 

A key signature can be invalid for a number of reasons, including: 

• Accidentals placed on the incorrect line or space. 

• Skipping one of the columns—accidentals must be 
adjacent to one another. 

Kapelle Scales follows the guidelines set forth in Music Notation, 
Second Edition, by Gardner Read (Boston: Crescendo Publishers, 
1969) for the proper placement of accidentals within a key 
signature. 

Here are some examples of invalid key signatures, with the reasons 
they are invalid: 

Signature Why Invalid 

 

The F# should be positioned on the 2 nd line of 
the staff, and not the top space. 
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The first column has been skipped. 

 

This is an unknown key signature (perhaps 
the bass clef wasn’t being observed.) 
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X. Playing a Scale 

Some exercise styles require you to play a scale on an attached 
MIDI keyboard. 

Kapelle Scales uses a special dialog box for MIDI input, in order to 
allow you to play the scale, control which scale degree you are 
playing, correct any errors, and even play the scale a number of 
times, without ever seeing any music notation. 

The Scale Playback Dialog is displayed automatically during any 
kind of scale playback exercise. It is not a moveable dialog, but is 
placed instead automatically where it will allow other necessary 
information to be seen. 

Understanding the Scale Playback Dialog 

 
Figure 28: The Scale Playback Dialog 

A horizontal row of Degree Buttons show you the following 
information: 

• Which scale degree is currently selected (is the target 
for the next note you play, in other words.) The 
selected scale degree is drawn in RED. 

• Whether you have played a note already for that scale 
degree, or whether it has not yet been played. A 
“filled” scale degree is drawn in WHITE. An “empty” 
scale degree is GRAY. 

NOTE: the numbers in the degree buttons are important. It is 
perfectly possible for a scale-playing task to specify that you start 
on a scale degree other than 1, and end on a scale degree other 
than 1. The numbers in the degree buttons will have been set to 
match the exercise requirements. 

Degree Buttons 
Playback Controls  
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Playing the Scale 

Playing the scale is simple enough: simply play the notes on the 
MIDI instrument and you will see the selected scale degree move 
one step ahead for every note you play. Once you reach the last 
note, the selected scale degree will loop around to rest once again 
at the first note. 

Don’t worry about which octave to use: Kapelle Scales will make 
the necessary adjustments once you’ve finished. But don’t go 
leaping around. 

Selecting a Scale Degree to Play 

If you want to play a note for a specific scale degree, simply click 
on the scale degree button and it will become selected. Then play 
the note. (The selected scale degree will then move one step 
ahead.) 

Playing Your Input 

After you have played the scale, you may want to audit your 
performance. To do this, click on the Play My Input button and 
the scale will be played. You may stop the playback before the end 
of the scale is reached with the Stop Play button. 

NOTE: the Play My Input button is not enabled until every scale 
degree contains a MIDI pitch—there must be no degree buttons in 
GRAY. 

Confirming Your Input and Exiting 

Once you are satisfied that you have performed the scale properly, 
click the OK button. Kapelle Scales will then notate the scale you 
have just played and will evaluate your work. 
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Octave Considerations in Scale Playback 

You may play the scale in any octave you wish. Kapelle Scales will 
ensure that the octave in which the scale is notated (and thus 
evaluated) lies properly within the confines of the clef. 
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XI. Progress Reports 

Accessing Your Progress Report 

To access your progress report, use the Show Progress Report 
command. You may access this command by any of the following 
techniques: 

• Press Ctrl+P. 

• Select Show Progress Report from the File Menu. 

• Click the Show Progress Report icon  on the 
Toolbar. 

The Contents of Your Progress Report 

A progress report is a special file created for you automatically by 
Kapelle Scales the first time you used the application. It contains a 
record of all of the exercises you have performed, together with 
their scores, and the date/time when you did each individual 
exercise. 

The progress report is shown in a special dialog box which allows 
you to manipulate the contents of your progress report: you can 
delete entries, sort the report by various criteria, filter out entries, 
as well as print or export your progress report as a text file. 
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Understanding the Progress Report Window 

 
Figure 29: The Progress Report Window 

The main area of the progress report window is devoted to a list 
box which displays each entry in the progress report. Each entry 
represents a single exercise, and each entry contains the following 
fields: 

• Name: the file name for this exercise. 

• Grade: the score you received for your work. 

• Date: the date and time you received this particular score. 

Sorting Entries 

You may sort the entries by any of the three fields—Name, Grade, 
and Date. Sort them by clicking on the field header: 

 
Figure 30: Sorting Entries by Date 
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Selecting Entries 

To select an entry, click on the Name field for that entry: 

 
Figure 31: Selecting an Entry 

To select an inclusive range of entry, click on the Name field for the 
first entry in the range, and then hold down the Shift key and click 
on the Date field for the last entry in the range: 

 
Figure 32: Selecting an inclusive range of entries 

To select multiple, non-continguous entries, hold down the Control 
key and click on each entry you wish to select: 

 
Figure 33: Selecting Non-Contiguous Entries 

Deleting Entries 

To delete an entry, select the entry or entries you wish to delete 
(see the above section on selection techniques) and then click on 
the “Delete Item” button on the top of the window: 

 
Figure 34: Deleting Entries 
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NOTE: the item will not be permanently deleted unless you click on 
the “Save/Close” button, which saves the changes you have made 
in your progress report. If you click on the “Close” button instead, 
you will be given the option to close your report without saving 
changes. 

Filtering Entries 

You may filter the entries in the progress window—that is, include 
only those entries which you want to see. This feature can be very 
useful if you are printing a progress report since reports can grow 
very long quickly. You may filter by Date, by Exercise, or by Grade. 

Note that filtering does not remove the items from your 
Progress Report: it determines how they are displayed and 
printed only; the contents of the actual file remain 
unchanged. 

To reach the filters, click on the “Filter” button: 

 
Figure 35: Location of the Progress Report Buttons 

You will be presented with the Filters property sheet, which is a 
“tabbed” dialog box—each tab controls one specific filter. Go to 
each property page by clicking on its tab: 

 
Figure 36: The Filters Property Sheet 

Filter by Date 

You may filter entries to those occurring within a specific time 
frame, measured from the present: 
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Figure 37: Filter by Date Property Page 

To select an option, click on the radio button that selects that filter, 
and then select a range of options. In this illustration, only those 
exercises which have been done within the last 3 days will be 
displayed: 

 
Figure 38: A Sample Filter 

Date filters operate up to a year in the past—you may show those 
entries created up the last 365 days, or the last 52 weeks, or the 
last 12 months. 

Filter by Exercise 

You may restrict the display to only those exercises you choose: 

 
Figure 39: Filter by Exercises Property Page 

Select exercises to be displayed by clicking on the check box to the 
left of the exercise. Checked exercises are displayed, unchecked 
ones are not. Note that you may select or deselect all of the items 
quickly by using the Select All and Clear All buttons. 
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Filter by Grade 

Finally, you may restrict your display to just those exercises that 
fall within a range of scores: 

 
Figure 40: The Filter by Score Property Page 

Removing Filters 

If you have filtered your progress report, you may remove the 
filters by clicking on the “Remove Filters” button at the top of the 
Progress Report window: 

 
Figure 41: Location of the Remove Filters button 

NOTE: the “Remove Filters” button is activated only if you have 
filtered your progress report. 

Printing Your Progress Report 

To print your progress report, click the “Print” button: 

 
Figure 42: Location of the Print button 

If you have filtered your progress report, you will be asked if you 
want to print the filtered set of records, or the entire report: 

 
Figure 43: Printing a filtered report 

Printing will then proceed.  
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NOTE: Kapelle Scales uses WordPad, which is installed 
automatically along with Windows, for printing. If WordPad is not 
installed, an error message will result and you will not be able to 
print. 

Exporting Your Progress Report 

You may export your progress report to a plain-text, tab-delimited 
file, suitable for importing into a spreadsheet or database 
application. 

To export your progress report, click on the “Export” button. You 
are presented with a standard Windows Save As dialog box: 

 
Figure 44: Save As Dialog Box 

Kapelle Scales offers a default name for your progress report; you 
may change this to suit yourself. Use the Save As dialog box to 
navigate to the location where you want to save the exported 
progress report, then click Save. 

NOTE: an exported progress report is always the complete set of 
entries, whether or not the report has been filtered. 

Closing the Progress Report Dialog Box 

To close the Progress Report dialog box, click either Save/Close or 
the Close button. Save/Close will automatically save changes you 
have made, and then close the dialog box. 

Clicking on the Close button will give you the option of saving any 
changes you may have made prior to closing the dialog box: 
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Figure 45: Closing the Progress Report 

Note that any changes you have made—sorting, filtering, deleting—
are not saved permanently to the progress report file unless you 
specifically indicate that the changes are to be saved, either by 
clicking the Save/Close button, or by clicking on Close and then 
clicking “Yes” in response to the query about saving your changes. 
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XII. Saving and Restoring Your Place 

You might need to pause for a while when working through an 
exercise and come back to it later. For that purpose, Kapelle Scales 
allows you to save and restore your place in an exercise. 

Saving Your Place in an Exercise 

To save your place in an exercise, select Save Your Place… from 
the File Menu. 

An information box will tell you what you are about to do: 

 
Figure 46: Save Your Place Information Dialog 

The critical information here is that the current exercise will be 
removed once you have saved your place—in other words, you 
cannot save your place and just continue working on the exercise. 

Click Yes (or press Enter) to confirm this action, or No if you 
would rather not. 

Restoring Your Place in an Exercise 

If you have saved your place in any exercises previously, the 
Return to Your Place… command on the File Menu will be 
enabled. 

To return to your place in a previous exercise, give this command. 
The following informative dialog box will be presented: 
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Figure 47: Return to Your Place Information Dialog 

The critical issue here is that the current exercise will be closed if 
you restore a previous exercise. Click Yes if this is all right with 
you, or No if you would rather not restore an exercise right now. 

If you have saved your placed in only one exercise previously, the 
restoration will happen immediately upon clicking Yes. 

However, if there are multiple saved exercises available, Kapelle 
Scales will present you with a list from which you can choose: 

 
Figure 48: Choose Exercise State File Dialog Box 

The name of the “Exercise State File” reflects the following 
information: 

• The name of the exercise. 

• The date on which you saved your place in this 
exercise. 

• The time at which you saved your place in this 
exercise. (The time format is hhmmssAM/PM—so it 
might be a bit tricky to read). 

Select the exercise you wish to restore, and click OK. 

NOTE: you can restore your place in an exercise only once. Once it 
has been restored, the exercise state file that contained the 
information is automatically deleted. You may, of course, save your 
place again. 
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NOTE: the “restored” exercise may not contain precisely the same 
scales as the one you saved. The actual notation material itself is 
not saved when you save your place—just the information about 
where you were in a particular exercise, the exercise to create, and 
your scores. Restoring your place generates a new exercise from 
the same template as previously, and sets up your place and scores 
in the exercise to match that when you saved your place. 
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XIII. Adjusting MIDI Settings 

The MIDI Settings Dialog Box 

Kapelle Scales’s MIDI Settings are all reached via the MIDI Settings 
dialog box. Use this dialog box to set input and output ports, output 
channels, output programs, and the MIDI Thru feature. 

To adjust your MIDI settings, use the Midi Settings command, 
located on the Playback Menu. 

The MIDI Settings dialog box is displayed: 

 
Figure 49: MIDI Settings dialog box 

Setting the MIDI Input and Output Ports 

To set your MIDI Input and Output ports, use the list boxes in the 
MIDI Settings dialog box. Both of these will allow you to choose 
from available devices on your system: 

 
Figure 50: MIDI Input and Output ports 

NOTE: most systems will have only one MIDI Input port, but may 
well have several output ports. 

NOTE: Kapelle Scales uses MIDI input only during the scale-playing 
styles. In all other exercise styles, MIDI input is explicitly disabled. 
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Setting Output Channels 

The MIDI Output Channel determines which of the standard 16 
MIDI channels Kapelle Intervals uses for MIDI output. Kapelle 
Scales’s playback is always through one single MIDI channel. Use 
the Channel slider to select a value between 1 and 16: 

 
Figure 51: MIDI Output Channel selector 

Setting Output Programs 

Kapelle Scales will set your MIDI device to play using any one of its 
available programs, from 1 through 256. You may use the slider to 
set the program, or you may select the output by name.  

 
Figure 52: Output program slider 

To select the MIDI program by name, click on the Select By Name 
button. This presents you with the Select Program dialog box: 

 
Figure 53: Select Program dialog box 

Select an instrument from the Instrument drop down list, then 
select a program from the list of available programs by clicking on 
the program name and then clicking on the OK button (or double-
click on the program’s name). 

Setting MIDI Thru 

The MIDI Thru setting is automatic in Kapelle Scales, since MIDI 
Input (and hence MIDI Thru) is enabled only for a few exercise 
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styles. MIDI Thru is taken in at the Input channel, and out at the 
playback channel—there is no other setting possible. (Both the 
MIDI Thru button and channel sliders are disabled.) 
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XIV. Playback 

In a number of exercise styles scales are played. In other styles, 
you may wish to play the scale that you have notated (or played). 

Playing a Scale 

To play a scale, use the Play Scale command on the Playback 
Menu. 

The Play Scale command can be accessed by any of the following 
techniques: 

• Press the Spacebar. 

• Select Play Scale from the Playback Menu. 

• Click the Play Scale icon  on the Toolbar. 

• Right-click in the Notation Pane and select Play Scale 
from the Context Menu. 

Playing Your Notated Scale 

After a scale has been evaluated, you may wish to play your 
version of the scale to make an aural comparison with the “correct” 
scale. To do this, use the Play My Scale command. 

The Play My Scale command may be accessed by any of the 
following techniques: 

• Press Ctrl+Spacebar. 

• Select Play My Scale from the Playback Menu. 

• Click the Play My Scale icon  on the Toolbar. 
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• Right-click in the Notation Pane and select Play Scale 
from the Context Menu. 

Setting the Playback Tempo 

You may set the tempo for playback via the Set Tempo command. 
The tempo may be adjusted from 1 to 255 beats per minute. 

The Set Tempo command may be accessed by any of the following 
techniques: 

• Press Ctrl+M. 

• Select Set Tempo from the Playback Menu. 

This command displays the Set Tempo Dialog Box. 

 
Figure 54: Set Tempo Dialog Box 

Move the control slider to the new tempo, then click OK (or press 
Enter.) 

TIP: if the control slider is selected (has a light gray rectangle 
around it) you can move the slider bar with the left and right arrow 
keys. 

Stopping Playback 

To stop playback, use the Stop command. 

The Stop command can be accessed by any of the following 
techniques: 

• Press the Spacebar. 
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• Select Stop from the Playback Menu. 

• Click the Stop icon  on the Toolbar. 
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XV. Setting Colors 

You may select many of the colors used for the interface in Kapelle 
Scales. 

Parts of the Interface With User-Selected Color 

You may set the color for the following interface elements: 

• User Area Background: the background color for the 
Notation Pane. 

• User Area Text: the color of the text in the Notation 
Pane color bar. 

• User Area Color Bands: the color of the Notation Pane 
color bar. 

• User Area Notation: the color of the music notation in 
the Notation Pane. 

• Source Area Background: the background color for the 
Source Pane. 

• Source Area Text: the color of the text in the Source 
Pane color bar. 

• Source Area Color Bands: the color of the Source Pane 
color bar. 

• Source Area Notation: the color of the music notation 
in the Source Pane. 

• Background: the color of the Main Window background 
(all areas not filled by a pane.) 

Accesing the Colors Command 

To set the interface colors, use the Colors… command, located on 
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the View Menu. This command displays the Colors Dialog Box. 

 
Figure 55: Colors Dialog Box 

Using the Colors Dialog Box 

Selecting an Interface Element 

You may select an interface element by either: 

• Selecting the element from the drop-down list, then 
clicking the Change Color button. 

• Clicking on the element in the display area. Double-
clicking will both select the element and click the 
Change Color button automatically. 

Changing the Color 

Select the color you want from the pre-selected list of colors, or 
create a custom color using the color dialog. 

Setting a Single Element to Default 

If you wish to set an interface element back to its default color: 

• Select the element from the drop-down list (or click on 
it in the display), then click the Default button. 

Setting All Elements to Default 

If you wish to set all interface elements back to their defaults, click 
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on the Default All button. 
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XVI. About the Scales.kpl File 

The file Scales.kpl is a Kapelle-format file which must be present in 
Kapelle Scales’s application directory for the program to operate. 

Scales.kpl contains a music notation document which specifies the 
scales known to Kapelle Scales together with their names. 

The format of the files is as follows: 

• One measure lists the ascending form of the scale, 
notated upwards from middle ‘c’. 

• The next measure lists the descending form of the 
scale, notated downwards from ‘c’ on the third space 
of the treble clef. 

The measure containing the ascending form of the scale contains 
one TextBlock object which gives the mode’s name in two forms: a 
long form used in the Kapelle Scales program, and a short form 
which is used in exercise template files to specify the use of that 
mode. The names are case-specific, and therefore ‘M’ is different 
from ‘m’. The colon character (:) is used to separate the two. 

For example, the Dorian mode is listed as “Dorian:do”. 

At shipment, Scales.kpl contains the following scales: 

Full Name Abbreviated Name 
Major M 
Natural Minor nm 
Harmonic Minor hm 
Melodic Minor mm 
Ionian io 
Dorian do 
Phrygian ph 
Lydian ly 
Mixolydian mx 
Aeolian ao 
Locrian lo 
Super Locrian sl 
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Neapolitan Minor pm 
Neapolitan Major pM 
Oriental or 
Double Harmonic dh 
Enigmatic en 
Hungarian Minor gm 
Major Locrian Ml 
Lydian Minor lm 
Overtone ov 
Leading Whole-Tone lw 
Hungarian Major gM 
Five-tone Diatonic 5d 
Five-tone Pelog 5p 
Five-tone Hirajoshi 5h 
Five-tone Kumoi 5k 
Six-tone Symmetrical 6s 
Six-tone Prometheus 6p 
Six-tone Prometheus Neapolitan 6n 
Six-tone Whole-tone 6w 
Eight-tone Symmetrical 8s 
Eight-tone Spanish 8p 

To Add New Modes to Scales.kpl 

If you would like to add a new mode to Scales.kpl, follow these 
instructions: 

• Open Scales.kpl using the application Kapelle. 

• Add two measures to the end of the file. 

• Set the meter of those two measures to a half-note 
based meter that will fit the scale you are writing. 
Five-tone scales require 6/2; Six-tone scales 7/2; 
Seven-tone scales 8/2, and so forth. 

• Notate the ascending form of the scale in the first 
measure, starting from middle ‘c’. 

• Notate the descending form of the scale in the second 
measure, starting from the ‘c’ on the third space. 

• Add a TextBlock to the first measure, and put in the 
long form and short form of the name for the text, 
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using the format [LongForm]:[ShortForm]. For 
example, Roumanian Minor would be “Roumanian 
Minor:rm” 

Observe the following precautions when naming modes: 

• Do not use names which have already been used: 
carefully check through the list, especially checking 
the short forms. 

• Retain the use of ‘m’ for minor and ‘M’ for major in 
short forms. 

• Retain the use of numbers for non-seven-tone scales 
(thus 5 for pentatonic, 6 for hexatonic, and so forth.) 

Be sure to give the mode the appropriate names! If you do 
not name the mode properly, it will be listed as “Unknown Scale” 
when it is loaded in by the application. 

Before adding any new modes to Scales.kpl, it is strongly 
recommended that you open the file using Kapelle and study its 
organization and nomenclature style. 
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XVII. System Requirements 

Kapelle Scales is a 32-bit Windows application. It is designed to run 
on Microsoft Windows in any of its fully 32-bit incarnations. This 
includes the following versions: 

• Windows 95 

• Windows 98 

• Windows NT 3.5 

• Windows NT 3.51 

• Windows NT 4.0 

Kapelle Scales has been tested on these platforms and has been 
found to run properly on all of them. 

Kapelle Scales will not run on the following implementations of 
Windows: 

• Windows 3.1 or earlier, whether or not it uses the 
Win32s subsystem. 

• The Win/OS2 subsystem of OS/2 Warp. 

• Linux-based Windows emulators that do not emulate 
the full Win32 API. 

Kapelle Scales has not been tested for compatibility with any of the 
Macintosh or Unix-based Windows software emulators such as 
SoftWindows or VirtualPC. 

For sound output, Kapelle Scales requires a Windows-compatible 
sound card with MIDI features. Since Kapelle Scales uses the 
underlying Windows Multimedia features for playback and input, as 
long as the sound card works with Windows it should work with 
Kapelle Scales. 
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For MIDI Input, Kapelle Scales requires a MIDI instrument of some 
sort connected to the computer, via either the sound card or a 
separate MIDI interface card. Most modern sound cards provided a 
MIDI input/output port as part of the external joystick connection; 
MIDI cables can be attached to this via an inexpensive cable 
converter. 
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XVIII. Technical Information 

Kapelle Scales is written in the C++ programming language, using 
Microsoft Visual C++. 

The application is written using the Microsoft Foundation Classes 
(MFC) library. 

Kapelle Scales is linked to the Apollo music notation library, by the 
same author, which provides it with its music notation and playback 
capabilities. 

Exercise Template Files 

Exercise template files have the extension “ksi” and consist of 
single lines of text. Each line begins with a keyword, followed by an 
equals sign, and then the appropriate information for that keyword. 

The structure of the keywords and their possible values is as 
follows: 

Keyword Meaning Values 

style The actual style for the exercise. The 
value must be ONE of the possibilities. 

writeDegree, 
writeStartNote, 
addAccs, addSig, 
idSightKeySig, 
idSightAccs, 
singleDegree, 
idEarKey, 
idEarModeOnly, 
errorCorrect, 
playScaleKey, 
playScaleStartNo
te 

keySig Whether or not to use a key signature 
when drawing a scale. 

TRUE/FALSE 

selKeySig Whether or not for the user to select a 
key signature from a list of possibilities. 

TRUE/FALSE 

createKeySig Whether or not for the user to create a 
key signature from scratch. 

TRUE/FALSE 

clefs A list of clefs to use with the exercise. 
May be any or all of the value list. 

treble, soprano, 
mezzo, alto, 
tenor, baritoneC, 
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baritoneF, bass 

degreeBounds The first number indicates the starting 
scale degree, and the second number the 
ending scale degree. Numbers must be 1 
through the highest possible scale 
degree. As many pairs may be specified 
as desired. 

a:b, c:d, e:f…y:z 

ascend Whether or not to use ascending scales. TRUE/FALSE 

descend Whether or not to use descending scales. TRUE/FALSE 

degreesSingle The specified degrees which are used in 
‘singleDegree’ style. The degree must be 
within the scale—1 through the highest 
possible scale degree. 

1,2,3,4,5,6,7…n 

numErrorsPerScale  The number of errors which may be 
added to a scale in errorCorrect style. If 
the number is preceded by *, then the 
scale MUST contain that many errors. 
The number is from 1 to the maximum 
number of notes in the scale. 

(*)1…n 

degreeErrors  A list of scale degrees which may have 
errors. If the number is preceded by *, 
then that specific scale degree MUST 
have an error. The number can be from 
1 to the highest scale degree for that 
scale. 

(*)1…n 

scales A list of the scales to use in the exercise. 
The tonic is given first (uppercase) 
followed by an accidental if necessary, 
followed by the short form of the mode 
to use. C-sharp major would be C#M, for 
example. 

keyAccMode, 
keyAccMode…n 

modes The list of the modes to use in the 
exercise, in their short form. 

mode, mode…n 

specifyScales If TRUE, the ‘scales’ list should be 
consulted to construct the exercise. If 
FALSE, then the ‘modes’ list should be 
consulted. 

TRUE/FALSE 

writeAcc IF TRUE, the user should write in scale 
accidentals as needed. 

TRUE/FALSE 

allDegreeErrors IF TRUE, the errorCorrect style will 
create errors on scale degrees at 
random. If FALSE, the ‘degreeErrors’ list 
will be consulted instead. 

TRUE/FALSE 
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DefaultPath.txt File 

The file DefaultPath.txt must be present in the application directory 
if the set of exercise template files is located elsewhere than in the 
application directory. 

The file contains one line of text, which is the full path to the top 
directory where the exercise template files are to be found. 

Executable Program Size and Memory 
Requirements 

The Kapelle Scales executable is self-contained and requires no 
external DLLs. It is 829KB in size. 

The program’s memory requirements vary during operation, but 
the average memory requirement is between 3.5MB and 4.0MB. 

Error Reporting 

Kapelle Scales contains a very robust error-reporting mechanism 
that should help to protect the user against any foreseeable 
problems. 

The application responds to error conditions in three different 
modes of severity: 

• In the least severe mode, the error is written to a file 
ErrorLog.log in the application directory. The entry 
contains the date and time of the posting, an error ID 
number, and the name of the error. The error is not 
reported to the user given that it should not impact 
significantly on the program operation from the user’s 
point of view. 

• In the next highest mode, the error is reported to the 
user in addition to being written to the log. The user is 
warned that this error might impact on the program’s 
operation. 
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• In the highest mode, the error is reported to the user, 
is written to the log, and then the application is 
terminated. The error is judged severe enough as to 
severely impact the application’s performance, and 
therefore an attempt is made to exit gracefully. 

NOTE: if the program terminates abnormally (not going through the 
error conditions outlined above) during an exercise play style—or 
while playback is occurring, it is possible that the MIDI Output or 
Input port will be left “dangling”. This means that the port is still 
connected, but the actual connection itself has been lost. When this 
happens, subsequent launchings of the program will result in a 
MIDI error. The only way around this is to restart the computer. 

However, abnormal program termination when playback is not 
occuring—or not during an exercise play style—will not affect the 
MIDI ports. 


